
 

 

  

COURSE OUTLINE                       

ELECTRONIC DOCUMENT 

PREPARATION AND 

MANAGEMENT (EDPM) 
 

      

 



Curriculum Area: Electronic Document Preparation and Management GRADE 10 

 

 

 

 

 

COURSE OUTLINE – GRADE10 

 

ELECTRONIC DOCUMENT 

PREPARATION AND MANAGEMENT 

(EDPM) 
 

 

 

 

 

 

 

 

 

 

 
 



Curriculum Area: Electronic Document Preparation and Management 

GRADE 10 

Page ii of 72 

 

 



GRADE 10 

Page 1 of 72 

 

 

 

WEEK 1 

TOPIC/ SUB- 

TOPIC 

GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION I: 

FUNDAMENTALS 

OF COMPUTING 

What is a 

Computer? 

 

Types of computers 

Students will: 

i. become familiar with the 

concept of a computer; 

 

 

 

 

 

ii. develop an awareness of 

the types of computers. 

What is a computer? 

A computer is an electronic machine that accepts input 

(data), processes that input and stores or outputs the resulting 

information. 

 

 

 

 

Types of computers 

Classification by shape, size, speed and power: 

i. Mainframe 

ii. Minicomputer 

iii. Microcomputers: 

✓ Desktop 

✓ Laptop 

✓ Tablet PC 

✓ Palmtop, Handheld, Smartphone or Mobile 

Computer. 

Defining the term 

‘computer’. 

 

 

 

 

 

 

 

Identifying the types of 

computers 

 

Explaining the types of 

computers 

Textbooks 

Electronic Document 

Preparation and 

Management, 

Caribbean Educational 

Publishers, 2021 

Pages: 1 – 3 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 1 – 4 

Oral discussion 

Research 
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WEEK 2 

TOPIC/ SUB- 

TOPIC 
GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION I: 

FUNDAMENTALS 

OF COMPUTING 

 

Advantages and 

disadvantages of 

computer usage 

 

 

 

 

 

 

 

Components of a 

computer system 

Students will: 

i. develop an 

understanding of the 

advantages and 

disadvantages of 

computer usage; 

 

 

 

 

 

 

 

 

 

 

ii. develop an awareness of 

the components of a 

computer system. 

Advantages and disadvantages of computer usage 

Advantages include: 

i. increased speed with which the task is done; 

ii. consistency and accuracy of the results produced; 

iii. enhanced storage capabilities using a wide range of 

high-capacity, low-cost 

iv. reliability that organisations can depend on. 

Disadvantages include: 

i. it is easier for the security and integrity of data to be 

compromised; 

ii. the initial cost of required components for setting up 

a computer system is high. 

 

Components of a computer system: hardware, peripherals, 

software, user, procedures and data. 

Discussing the 

advantages and 

disadvantages of 

computer usage 

 

Stating the advantages 

and disadvantages of 

computer usage 

 

 

 

 

 

 

 

Explaining the 

components of a 

computer system 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 4 – 5 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 4 – 5 

Oral discussion 

 

 

PowerPoint 

Presentation 

 

Quiz 
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WEEK 3 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION I: 

FUNDAMENTALS 

OF COMPUTING 

 

Input devices 

 

 

 

 

 

 

Output devices 

 

 

 

 

 

 

 

 

 

 

 

 

Types of storage media 

Students will: 

i. become familiar with the 

concept input devices; 

 

 

 

 

 

 

 

 

 

 

ii. become familiar with the 

concept output devices; 

What is an input device? 

An input device is a specialized peripheral that serves to 

get data from users and the environment and prepare it for 

processing or storage. 

 

 

What is an output device? 

An output device is a specialized hardware component 

that allows the end user to look at or listen to the results of 

the processing ACTIVITY. 

Defining the term 

input device. 

 

Listing examples of 

input devices 

 

Explaining the use of 

the various input 

devices 

 

Defining the term 

output device. 

 

Listing examples of 

output devices 

 

Explaining the use of 

the various output 

devices 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 6 – 8 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Page: 7 – 20 

Oral discussion 

Research 

Group presentation 

Oral Quiz 
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 iii. develop an awareness of 

the various types of 

storage media and their 

practical applications. 

What is a storage device? 

A storage device is a hardware component that keeps data, 

information, and program instructions permanently. 

 

Types of computer storage media: 

i. Primary Storage Devices (Internal storage). 

ROM 

RAM 

ii. Secondary Storage Devices (Internal or External) 

✓ Hard disk drive (HDD) 

✓ Floppy disk drive (FDD) 

✓ CD-ROM/DVD-ROM drive 

✓ USB drive 

Defining the term 

storage device. 

 

 

Listing the types of 

computer storage 

media 

 

Explaining the types 

of memory 

 

Explaining the types 

of drives 

 

Stating their practical 

applications 

 

 

Electronic Document 

Preparation and 

Management, 

Caribbean Educational 

Publishers, 2021 

Pages: 9 – 12 
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WEEK 4 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION I: 

FUNDAMENTALS 

OF COMPUTING 

 

Software 

 

 

Types of software 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Caring for computers 

Students will: 

i. Develop an 

understanding of 

software; 

ii. Develop an awareness of 

operating system 

software and application 

software; 

Software 

Software is the name given to the programs that run on a 

computer. The software consists of instructions that tell 

the computer what to do. 

Operating System Software 

Programmes that coordinate the ACTIVITY among 

computer devices. They contain instructions that allow the 

user to run application software. 

Application Software 

Programmes that perform specific tasks for users, 

including, word processing software, spreadsheet 

software, database management software, presentation 

software, and anti-virus 

 

 

Defining software 

 

 

Defining operating 

system software 

 

Listing examples of 

operating system 

software 

 

Defining application 

software 

 

Listing examples of 

application software 

 

Distinguishing 

between operating 

system software and 

application software 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 11 – 15 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 21 – 4 and 

32 – 6 

Oral discussion 

Quiz 

Video Presentation 
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and peripherals in the 

working environment 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Discuss health and 

safety factors 

associated with 

computer use 

iii. Develop the knowledge, 

skills and competencies 

to function effectively in 

a technological 

environment. 

Care when working with computers 

Caring for computer hardware: cover hardware when not 

in use, use a soft, damp cloth to clean the screen of the 

monitor regularly, and eat and drink only in areas away 

from where the equipment is located. 

 

Caring for your working environment: use suitable 

furniture that is capable of bearing the weight of the 

equipment, keep cables neatly arranged and out of 

walkways to avoid trip hazards, and do not overload 

electrical outlets to avoid fire hazards. 

 

 

 

Taking care of yourself – the computer user 

Some tips for taking care of yourself include: ensuring 

that your chair and desk are the correct height, avoiding 

extended use of the equipment, and ensuring that the 

lighting is adequate. 

 

Health Ergonomics: effects of extended use, inadequate 

lighting, inappropriate furniture, bad posture. 

Safety: Overloading electrical sockets, position of 

workstations, location of extension cords. 

Describing ways of 

caring for computers 

and peripherals in the 

working environment 

 

Defining the term 

ergonomics 

 

 

 

Discussing health 

factors associated with 

computer use. 

 

Discussing safety 

factors associated with 

computer use. 
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Additional Resources 

Website 

(278) Computer Basics: What Is a Computer? - YouTube 

(278) COMPUTER INPUT AND OUTPUT DEVICES FOR CHILDREN || BASIC COMPUTER || COMPUTER FUNDAMENTALS - YouTube 

(278) Storage Devices - YouTube 

(279) TYPES OF SOFTWARE || APPLICATION SOFTWARE || SYSTEM SOFTWARE || UTILITY SOFTWARE || COMPUTER BASICS - YouTube 

(279) How to take Good Care of your Computer - YouTube 

(279) Health and Safety Authority (HSA) — Correct Sitting Position at a Desktop Computer - YouTube 

 

 

 

Other suggested Teaching and Learning ACTIVITY facilitate students’ attainment of the objectives of this Section. 

 

Teachers/facilitators are encouraged to engage students in the teaching and learning ACTIVITY below. 

Arrange students into small groups and assign them research ACTIVITY that requires the gathering of information about computers and computing. In addition to text, they should gather 

pictures and samples of devices. Each group should present their findings to the class and at the end of these presentations, the teacher should add to the students’ findings where necessary to 

ensure understanding. The class should combine the pieces in a meaningful way and put them on a display for viewing by the school. 

https://www.youtube.com/watch?v=Cu3R5it4cQs
https://www.youtube.com/watch?v=DuYF3uD9AYQ
https://www.youtube.com/watch?v=OsEDJM9NuGA
https://www.youtube.com/watch?v=BTB86HeZVwk
https://www.youtube.com/watch?v=d2t5kbKG1aU
https://www.youtube.com/watch?v=PcsoeDpUSrs
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WEEK 5 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION II: 

KEYBOARD 

MASTERY 

 

Keyboarding 

techniques 

 

 

 

 

Posture at the 

computer 

Students will: 

i. demonstrate mastery in 

the operation of a 

QWERTY keyboard, 

utilizing the standard 

and function keys; 

 

 

 

 

 

 

ii. develop an awareness 

of the correct posture 

when using the 

computer system; 

The Keyboard 

The most used keyboard layout on English-language 

computers is called QWERTY. It takes its name from the 

first six characters on the left of the keyboard’s top row of 

letters. 

 

 

 

 

 

 

 

Posture at the computer 

Practice correct posture, arms reach, seat height, and eye 

level contact. 

Describing the layout of a 

standard Qwerty keyboard 

 

Identifying the function of 

various keys on the keyboard 

 

Displaying correct 

keyboarding techniques 

 

Demonstrating the correct 

posture at the computer 

Textbooks 

Electronic 

Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 25 – 8 

 

Electronic 

Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 69 – 70 and 

35 – 6 

Oral discussion 

 

 

Practical 

Demonstration 

 

Video 

Presentation 

 

Practical 

Exercise 
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Special keys 

 

 

 

 

 

 

Spacing after 

Punctuation marks 

iii. become familiar with 

the use of special keys; 

 

 

 

 

iv. become knowledgeable 

of the number of spaces 

that should be used 

after various 

punctuation marks. 

Use of special keys 

Apply special keys, for example, Tab, Escape, and Insert. 

Shortcut keys, for example, ctrl and alt; and Function keys, 

for example, F1. 

 

Spacing after Punctuation Marks 

 

No Space 

i. Before or after a comma in figure work e.g. $2,600 

ii. Before or after the hyphen in compound words e.g. 

part-time 

iii. Before or after an apostrophe in one word e.g. boy’s 

iv. After an open bracket or before a closing bracket e.g. 

(noon) 

v. Before or after a full stop separating abbreviations 

e.g. B.B.C. 

 

 

One Space 

i. After a comma, colon or semicolon 

ii. After an abbreviation within a sentence 

iii. After the initial letters of names preceding Surnames 

iv. Before or after the hyphen when it is used as a dash 

Demonstrating competence in 

the use of special keys 

 

 

 

 

Using correct spacing after 

punctuation marks 

 

 

 

 

 

Walmsley’s 

Commercial 

Typewriting 

Page 29 

 

Electronic 

Document 

Preparation and 

Management, 

Caribbean 

Educational 

Publishers, 2021 

Pages: 56 – 7 
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Two Spaces 

i. After an exclamation mark, a question mark or a full 

stop at the end of a sentence. 

 

Setting your margins 

The steps in setting margins are: 

i. click on the Page Layout tab; 

ii. select Margins; 

iii. choose: 

iv. Normal, which is already set at one inch for each side 

– top, bottom, left and right; or 

v. • Custom Margins to change the margins to suit your 

needs. 

 

 

 

 

 

 

 

 

 

 

Adjusting margins 
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WEEK 6 

TOPIC/ SUB- 

TOPIC 
GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION II: 

KEYBOARD 

MASTERY 

 

 

 

Touch typing 

Students will: 

i. demonstrate mastery in 

the operation of a 

QWERTY keyboard, 

utilizing the standard and 

function keys. 

Home keys 

The first set of keys that are being introduced is called the home 

keys. The row in which these keys are placed is referred to as the 

home row. Learning to type with these keys first allows you to 

effectively type with the others as the home fingers are used to 

depress keys in the same range, whether they are above or beneath 

the home row. The aim is for you to practice copy-typing. 

 

 

 

 

 

Identifying the home 

keys 

 

Displaying correct 

keyboarding 

techniques 

 

Demonstrating the 

correct posture at the 

computer 

 

Developing speed 

and accuracy in 

copy-typing 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 28 – 31 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 37 – 67 

Oral discussion 

 

 

Practical 

Demonstration 

 

Practical ACTIVITY 

in the form of typing 

games 
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  Practice ACTIVITY 
 

 

Use of fingers when typing other keys 

 

 
 

 

 Electronic Document 

Preparation and 

Management, 

Caribbean 

Educational 

Publishers, 2021 

Pages: 35 – 53 

 

 

Play Typing Games using Mavis Beacon or Free typing games, typing lessons and typing tests. | FreeTypingGame.net 

https://www.freetypinggame.net/
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WEEK 7 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION II: 

KEYBOARD 

MASTERY 

 

Touch typing 

Students will: 

i. demonstrate mastery in 

the operation of a 

QWERTY keyboard, 

utilizing the standard and 

function keys. 

Practice ACTIVITY 
 

 
 

 
 

 

Displaying correct 

keyboarding 

techniques 

 

Demonstrating the 

correct posture at the 

computer 

 

Developing speed and 

accuracy in copy- 

typing 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 31 – 33 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 37 – 67 

Oral discussion 

 

 

Practical 

Demonstration 

 

Practical ACTIVITY 

in the form of typing 

games 
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Electronic Document 

Preparation and 

Management, 

Caribbean Educational 

Publishers, 2021 

Pages: 35 – 53 
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GRADE 10 

Page 16 of 72 

 

 

 

WEEK 8 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION II: 

KEYBOARD 

MASTERY 

 

Touch typing 

Students will: 

i. Demonstrate mastery in 

the operation of a 

QWERTY keyboard, 

utilizing the standard 

and function keys. 

Practice ACTIVITY 
 

 
 

 
 

 

 

Displaying correct 

keyboarding 

techniques 

 

Demonstrating the 

correct posture at the 

computer 

 

Developing speed and 

accuracy in copy- 

typing 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 34 – 6 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 37 – 67 

Oral discussion 

 

 

Practical 

Demonstration 

 

 

 

Practical ACTIVITY 

in the form of typing 

games 
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 Electronic Document 

Preparation and 

Management, 

Caribbean Educational 

Publishers, 2021 

Pages: 35 – 53 

 

 

Play Typing Games using Mavis Beacon or Free typing games, typing lessons and typing tests. | FreeTypingGame.net 

https://www.freetypinggame.net/
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WEEK 9 

TOPIC/ SUB- 

TOPIC 
GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION II: 

KEYBOARD 

MASTERY 

 

Touch typing 

Students will: 

i. Demonstrate mastery in 

the operation of a 

QWERTY keyboard, 

utilizing the standard and 

function keys. 

Shift keys 

The shift keys are used when typing: 

i. capital letters; 

ii. characters found at the top of some keys. 

Keys with two characters 
 

 

Position of the shift keys 
 

 

Using the shift keys 

Displaying correct 

keyboarding 

techniques 

 

Demonstrating the 

correct posture at the 

computer 

 

Developing speed and 

accuracy in copy- 

typing 

Textbooks 

Electronic Document 

Preparation and 

Management for CSEC, 

Macmillan Education, 

2012. Pages: 36 – 8 

Electronic Document 

Preparation and 

Management for CSEC, 

2nd Edition, Oxford 

University Press, 2014 

Pages: 37 – 67 

 

Electronic Document 

Preparation and 

Management, Caribbean 

Educational Publishers, 

2021 Pages: 54 – 5 

Oral discussion 

 

 

Practical 

Demonstration 

 

Practical 

ACTIVITY in the 

form of typing 

games 
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WEEK 10 

TOPIC/ SUB- 

TOPIC 
GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION II: 

KEYBOARD 

MASTERY 

 

Manuscript 

 

 

Signs and 

terminologies 

Students will: 

i. develop an 

understanding of 

manuscript and 

manuscript signs; 

 

 

 

ii. interpret correction signs 

and terminologies used 

in document preparation. 

A manuscript is a handwritten or rough draft typed document 

that usually contains errors to be corrected. 
 

 
 

 
 

 

 

 

 

 

 

 

 

 

 

Defining the 

manuscript 

 

Identifying 

manuscript signs and 

notations 

 

Interpreting and 

applying manuscript 

signs 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 78, 90 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 Pages: 

118 – 19 

 

EDPM Syllabus 

Page: 39 – 40 

PowerPoint 

Presentation 

Practical Exercise 

Oral quiz 
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Play Typing Games using Mavis Beacon or Free typing games, typing lessons and typing tests. | FreeTypingGame.net 

https://www.freetypinggame.net/
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WEEK 11 

TOPIC/ SUB- 

TOPIC 

GENERAL 

OBJECTIVE 
CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION II: 

KEYBOARD 

MASTERY 

 

Types of 

headings 

Students will: 

i. become familiar 

with the concept 

types of headings 

and their use(s); 

Types of headings 

Headings indicate the main subject matter of a text to the reader. 

The headings for a particular text should be appropriately chosen as they help the 

reader decide whether or not to continue reading the document. Suitable fonts and 

styles may be used to emphasize the heading styles. 

 

Various types of headings: main heading, sub-heading, shoulder heading, 

paragraph heading, marginal or side heading, column heading and subject heading. 

 

 

Example of heading and sub-heading 

Explaining the 

term headings 

 

Listing the types 

of headings 

 

Creating 

presentable 

documents using 

various types of 

headings 

Textbooks 

Electronic 

Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 80 – 84 

 

Electronic 

Document 

Preparation and 

Management for 

CSEC, 2nd 

Edition, Oxford 

University Press, 

2014 

Pages: 115 – 17 

Oral discussion 

Research 

Oral quiz 

Practical Exercise 
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Types of Capitals ii. become aware of 

the various types 

of capitals. 

 

 

Using 

capitalization 

 

Identifying the 

types of capitals 

 

Discussing the 

types of capitals 

  

Play Typing Games using Mavis Beacon or Free typing games, typing lessons and typing tests. | FreeTypingGame.net 

https://www.freetypinggame.net/
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WEEK 12 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION II: 

KEYBOARD 

MASTERY 

 

Preparation of 

typescript from 

manuscript or type 

notes 

Students will: 

i. develop an 

understanding of the 

various types of 

paragraphs; 

 

ii. develop the knowledge 

to correctly use 

punctuation marks; 

 

iii. become aware of rules 

to abbreviate words; 

 

iv. develop the skill to 

prepare typescripts 

from manuscripts or 

typed notes using 

acceptable rules. 

Types of paragraphs 

In preparing documents various paragraph styles may be 

used. 

i. Blocked 

ii. Indented 

iii. Hanging 

iv. Inset 

Abbreviations 

Abbreviations are words that are in shortened form or are not 

spelt out. 

The use of punctuation marks 

Punctuation marks are marks or signs used within the text to 

clarify its meaning. 

 

 

Typescript 

A typescript is a typewritten version of a manuscript. 

Identifying and explaining 

the use of the types of 

paragraphs 

 

Using the various types of 

paragraphs in Word 

processor 

 

Defining the term 

abbreviation 

 

Replacing abbreviations 

with words in their 

extended form (vice versa) 

 

Using punctuation marks 

correctly 

Defining Typescript 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 84 – 89 and 

79 – 80 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 97 – 8 

Oral Questioning 

Research 

 

Written Quiz 
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WEEK 13 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION II: 

KEYBOARD 

MASTERY 

Students will: 

i. become familiar with 

mailable copy 

documents; 

Mailable copy 

A mailable copy is a document that is error-free, 

attractively laid out and ready to be submitted. 

i. Proofreading is the process of reviewing 

any text, either hard copy on paper or 

electronic copy on a computer, and checking 

for typos and formatting errors. 

ii. A typo is a typographical error – an 

unintentional error made during typing or 

typesetting. 

iii. Checking grammar is a ‘natural language’ 

grammar checker that flags possible 

problems by performing a comprehensive 

analysis of the text. 

iv. A thesaurus provides synonyms for a word. 

It is useful when the word you have used 

does not carry exactly the right 

Defining mailable copy 

 

 

Proofreading documents 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 78, 54 – 60 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 110 – 13 

Oral Questioning 

 

 

Practical Exercise 

  Identifying typos in documents Presentation 

 

Produce a 

professionally finished 

document 

ii. develop an 

understanding to 

proofread documents 

and identify typos; 

 

Using correct punctuation, 

grammar and spelling 

 

  Using the thesaurus  

Type at a minimum of 

35 words per minute 

iii. develop the knowledge 

to correctly use 

spelling, grammar and 

thesaurus; 

 

Producing mailable documents 

 

 
 

iv. develop an appreciation 

of language skills to 

Typing at a minimum of 35 

words per minute 
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 produce a 

professionally finished 

document. 

meaning.    

Additional Resources 

Website 

(5) The Perfect Ergonomic Desk Setup To Avoid Back & Neck Pain - YouTube 

(7) Touch Typing Basics| Keyboarding| CSEC EDPM - YouTube 

(5) Spacing after punctuation - YouTube 

(5) Blocked Style Manuscript Example| CSEC EDPM - YouTube 

(5) Types of Headings| CSEC EDPM - YouTube 

(5) Types of Paragraphs| CSEC EDPM - YouTube 

 

 

Other suggested Teaching and Learning ACTIVITY facilitate students’ attainment of the objectives of this Section. 

Teachers/facilitators are encouraged to engage students in the teaching and learning ACTIVITY below. 

To facilitate students’ attainment of the objectives of this syllabus, teachers are advised to engage students in the teaching and learning ACTIVITY listed below. Students should begin to 

practice and produce pieces relevant to the SBA assignments. The teacher should therefore identify typing exercises that allow them to practice techniques such as: 

1. Positioning fingers correctly on the Home Keys; 

2. Using keyboard shortcuts; 

3. Typing at a minimum speed of 35 wpm; 

4. Preparing typescripts from manuscripts; and, 

5. Preparing different documents according to established principles. 

https://www.youtube.com/watch?v=riD8Xt8r1MQ
https://www.youtube.com/watch?v=EebWkecsW38
https://www.youtube.com/watch?v=Ep9rpMRRCn8
https://www.youtube.com/watch?v=oLQ1JyIHJOc
https://www.youtube.com/watch?v=u2ParAPCHTY
https://www.youtube.com/watch?v=wOgYgR9VHmM


GRADE 10 

Page 26 of 72 

 

 

 

WEEK 14 

TOPIC/ SUB- 

TOPIC 
GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION III: 

INTRODUCTION 

TO 

APPLICATION 

SOFTWARE 

 

Types of 

application 

software: 

 

Word processor 

 

 

 

 

 

 

 

 

 

Guidelines and 

Students will: 

i. become aware of the 

purpose of Word 

processors; 

 

 

 

 

 

 

ii. become familiar with 

the undo and redo 

buttons; 

 

 

iii. acquire the knowledge 

to select text 

 

 

 

 

iv. develop an 

Word processing programs enable you to create, edit, format and 

print documents such as letters, papers and reports. Word 

Processors allow you to change the appearance of or format the 

words you type. You usually make these changes after you have 

typed the documents. Making changes to a typed document is 

called editing. Before you begin editing you should become 

familiar with two very useful buttons found on the standard 

toolbar: 

The Undo button allows you to reverse the last action you 

performed. 

The Redo button allows you to reverse the undo. 

 

 

Selecting text 

You must first select the typed text before it can be formatted. 

Selecting is the process of identifying to the computer the text you 

wish to change. The selected text looks like this. There are several 

methods of selecting text. 

Guidelines and methods of font formatting 

Recapping application 

software 

 

Explaining the 

purpose of Word 

processor 

 

 

 

 

Using the Undo and 

Redo buttons 

 

 

 

 

Selecting text 

Using different 

methods to select text 

Textbooks 

Electronic Document 

Preparation and 

Management, 

Caribbean Educational 

Publishers, 2021 

Pages: 88 – 119 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 68 – 77 and 

92 – 6 

Oral Questioning 

 

 

Practical 

Demonstration 

 

Practical Exercise 
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methods of font 

formatting 

 

 

 

 

Home Tab 

appreciation of the 

guidelines and methods 

of font formatting; 

 

 

v. become familiar with 

the formatting features 

on the home tab. 

The word font refers to the shape and size of the characters. 

Fonts may be plain or very decorative. 

 

 

 

 

The Home Tab 

i. Font styles 

ii. Changing font size 

iii. Changing font effects 

iv. Changing font colour 

v. Bold, underline, italic 

Explaining the term 

font 

 

 

 

 

 

Changing font styles, 

font sizes, font effects, 

font colour and using 

bold, underline and 

italic. 
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WEEK 15 

TOPIC/ SUB- 

TOPIC 
GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION III: 

INTRODUCTION 

TO 

APPLICATION 

SOFTWARE 

 

Line spacing 

Alignments 

 

 

 

 

 

 

 

 

 

 

Bullets and 

numbering 

Students will: 

i. develop an 

understanding of line 

spacing; 

 

 

 

 

 

 

 

 

 

ii. become familiar with 

alignments; 

Line spacing is the amount of space from the bottom of one line 

of text to the bottom of the next line. Microsoft Word adjusts the 

line spacing to accommodate the largest font or the tallest graphic 

in that line. You can change the spacing between the lines or the 

spacing before or after each paragraph. 

 

Alignments: left, right, centre and justify. 
 

 

 

 

Bullets and numbering 

Explaining the use of 

line spacing 

 

Using line spacing 

 

 

 

 

 

 

 

Selecting and using 

appropriate 

alignments 

 

 

 

Selecting and using 

appropriate bullets 

and numbering 

 

Customizing bullets 

Textbooks 

Electronic Document 

Preparation and 

Management, 

Caribbean Educational 

Publishers, 2021 

Pages: 88 – 119 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 68 – 77 and 

97 – 105 

Oral questioning 

 

 

Practical 

Demonstration 

 

Practical Exercise 
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Insert Tab 

iii. appropriately use bullets 

and numbering; 

 

 

iv. become familiar with 

the formatting features 

on the insert tab. 

A bullet is a symbol that is placed before the text to indicate a 

list of items. Alternatively, a list may be numbered. Microsoft 

Word offers several different numbering styles. 

Insert Tab 

i. Insert tables 

ii. Insert shapes 

iii. Insert SmartArt graphics 

iv. Insert text box 

v. Insert WordArt 

vi. Drop Cap 

vii. Insert symbol 

Many other symbols are not 

on your keyboard. You can 

use the Symbol dialogue box 

to enter these symbols 

anywhere in your document. 

 

 

 

 

 

Inserting a table, 

shapes, SmartArt 

graphics, text box, 

WordArt, Drop Cap 

and symbols 
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 WEEK 16 

TOPIC/ SUB- 

TOPIC 
GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION III: 

INTRODUCTION 

TO 

APPLICATION 

SOFTWARE 

 

 

 

Design Tab 

Layout Tab 

 

 

 

 

Reference Tab 

Students will: 

i. appropriately use the 

formatting features on 

the design tab; 

 

ii. become familiar with 

the layout tab and the 

use of its features; 

 

 

 

 

 

 

 

 

 

iii. develop an awareness 

of the use of the 

reference tab. 

Design Tab 

i. Watermark 

ii. Page colour 

iii. Page borders 

Layout Tab 

i. Margins 

The page margins are the blank spaces around the edges of the 

page. The printable area is the area inside the margins in which 

you insert the text and graphics. 

i. Orientation 

ii. Page size 

iii. Column 

iv. Breaks 

v. Indent 

Reference Tab 

i. Automatic table of contents 

ii. Footnote and Endnote 

iii. Citation 

 

Using watermark, 

page colour, page 

borders and shading 

 

Adjusting margins 

 

 

Applying orientation, 

page size, a column on 

the page, breaks and 

indent 

 

 

 

 

Using automatic table 

of contents, footnote, 

endnote and citation. 

Textbooks 

Electronic Document 

Preparation and 

Management, 

Caribbean Educational 

Publishers, 2021 

Pages: 88 – 119 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 97 – 105 

Oral questioning 

 

 

Practical 

Demonstration 

 

Practical Exercise 
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WEEK 17 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION IV: 

USE OF 

APPLICATION 

SOFTWARE 

Editing Techniques 

 

 

 

 

 

 

 

 

 

 

 

 

Drag-and-drop 

 

 

 

 

 

Find and replace 

Students will: 

i. appreciate the use of 

editing techniques 

when creating 

documents. 

ii. Editing is the process used to prepare a document for 

publication or presentation by correcting, revising or 

adapting the text. 

After a document is edited, it is customary for it to be 

formatted. 

iii. Formatting means changing the presentation and 

appearance of a document. 

 

 

Tools, techniques and features used in document editing and 

proofreading. 

Drag-and-drop 

You can also press and hold down the right mouse button and 

drag to the new destination then release the button. A menu 

appears that lets you choose an option. 

Defining the terms 

editing and 

formatting. 

 

 

Stating the tools, 

techniques and 

features used in 

document editing and 

proofreading. 

Adding and deleting 

text using overtypes 

and insert modes 

 

 

 

Moving text using 

drag-and-drop 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 54 – 57 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 111 – 12 

Oral questioning 

 

 

Practical 

Demonstration 

 

Practical Exercise 
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  Find and replace 

By using find and replace you can automatically replace text 

– for example, you can replace ‘CXC’ with ‘CSEC’. 

Using search tools to 

find and replace text 

  

An important point 

to note 

In order for the teacher to determine individual students’ readiness for Assignment One for the School-Based Assessment, the following activity is given as a 

diagnostic form of assessment. 

Produce a 

professionally 

finished document 

Students will: 

i. develop an appreciation 

of language skills to 

produce a professionally 

finished document. 

Further Practice ACTIVITY 

Correct use of punctuation, grammar, spelling and knowledge 

of abbreviation. 

Incorporation of all the skills in previous specific objectives. 
 

 
 

 

 

 

 

 

 

 

 

Identifying manuscript 

signs and notations 

Applying correction of 

manuscript signs and 

notations 

 

Identifying 

abbreviations and 

extend 

 

Using correct 

punctuation, grammar 

and spelling 

Producing mailable 

documents 

Typing at a minimum 

of 35 words per 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 91 – 92 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 122 – 31 

Practical Test 

Presentation 
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minute   
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WEEK 18 

TOPIC/ SUB- 

TOPIC 

GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SCHOOL-BASED 

ASSESSMENT: 

 

Assignment 1 

Students will: 

i. understand how to correct 

text from the author’s 

original work. 

Assignment 1 

In Assignment 1, students are expected to correct text from 

the author’s original work, which contains amendments, and 

respond to printers’ correction signs. Students are expected to 

present documents in a style consistent with universally 

accepted standards. 

Correcting text from 

the author’s original 

work, which contains 

amendments, and 

responding to printer’s 

correction signs. 

 

Presenting a document 

is a style consistent 

with universally 

accepted standards. 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 314 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 276 

Oral Discussion 

Practical Exercise 

Play Typing Games using Mavis Beacon or Free typing games, typing lessons and typing tests. | FreeTypingGame.net 
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WEEK 19 

TOPIC/ SUB-TOPIC GENERAL 

OBJECTIVE 
CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION IV: USE 

OF APPLICATION 

SOFTWARE 

 

Simple Tabulation 

 

 

Tabulation 

terminologies 

 

 

 

 

 

 

 

 

 

 

 

 

Work area in a 

worksheet 

Students will: 

i. become familiar with 

tabulation 

terminologies; 

Tabulation is the act or process of tabulating or arranging in 

tabular form – that is, into a table. A table is both a mode of visual 

communication and also a means of arranging data. 

A spreadsheet is a computer software that can capture, display 

and manipulate data arranged in rows and columns. 

 

A worksheet is a single working area in a spreadsheet file, 

consisting of a grid of lettered columns and numbered rows. 

A workbook is a collection of related spreadsheets that are saved 

as one file. 
 

 

Some spreadsheet terminology 

Defining the terms 

tabulation and 

spreadsheet 

 

Explaining the 

purpose of a 

spreadsheet 

 

Opening an Excel 

workbook 

 

Distinguish between 

worksheet and 

workbook 

 

Identify and describe 

spreadsheet 

terminology 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 102 

 

 

 

Electronic Document 

Preparation and 

Management, 

Caribbean 

Educational 

Publishers, 2021 

Pages: 129 – 57 

Oral questioning 

 

 

Practical 

Demonstration 

 

Practical Exercise 
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Cell size 

 

 

 

 

 

 

 

 

 

 

 

Column width 

ii. develop an 

understanding of the 

work area in a 

worksheet; 

 

 

 

 

 

 

 

 

iii. become aware of how 

to alter cell size; 

 

 

 

 

 

 

 

 

 

iv. develop an 

understanding of how to 

alter column width; 

Selecting a work area in a worksheet 

1. Click on a cell to select it. Click the first cell in the row 

to select a Continuous Range and drag the mouse 

pointer to the right and downward/upward to the last cell 

in the range. 

2. Lick the column letter at the top of the cell to select a 

column. 

3. To select Discontinuous Ranges, select the first range, 

press the Ctrl key and select another non-adjacent 

range. 

 

Altering cell size 

When you create a new workbook, all the rows have Auto 

heights – the height to fit the font size as displayed in the font 

size button (Calibri 11) of the active Excel window. All the 

columns have the same width. The symbol “####” in any cell 

with a value entry, indicates the column width is too small. Add 

more points to increase the width. 1 point = 12 pixels 

 

Altering column width 

1. Position the cursor between the column headings on the 

right border of the column whose width you would like 

Selecting a work area 

in a worksheet 

 

Moving around in a 

worksheet 

 

Entering text data or 

constant values in a 

worksheet 

 

 

 

Altering cell size 

 

 

 

 

 

 

 

 

 

 

 

Altering column 

width 
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Delete cell contents 

Row height 

 

 

 

 

 

 

 

 

 

Merge cells 

 

 

 

 

 

Insertion of columns 

and rows 

 

 

 

 

 

v. know how to delete cell 

contents; 

vi. develop an 

understanding of how to 

alter row height; 

 

 

 

 

 

 

 

 

vii. become familiar with 

merging cells; 

 

 

 

viii. become familiar with 

inserting new columns and 

rows; 

to change. Observe that the cursor changes . 

2. Drag the pointer either to the left or the right to increase 

or reduce the points until you get the desired width to 

accommodate the data and then release the mouse 

button. 

Deleting cell contents 

Select the cell and click the delete key. 

Altering row height 

1. Position the cursor between the row headings on the 

bottom border of the row whose height you would like 

to change. 

2. Drag the cursor to the bottom to increase the points 

until you get the desired height to accommodate the data 

and then release the mouse button. 

 

 

Merging cells 

Select the range that you want to merge and on the Home tab, in 

the Alignment group, click the Merge & Centre button. 

 

Inserting a new column to the left or right of any column 

 

 

 

 

 

Deleting cell contents 

Altering row height 

 

 

 

 

 

 

 

 

 

Splitting cells 

Merging cells 

 

 

 

Inserting a new 

column to the left or 

right of any column 
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New worksheet 

 

 

 

 

 

 

 

 

 

 

 

 

Sorting 

 

 

 

 

 

 

Wrap Text 

 

 

 

 

 

ix. know how to insert a 

new worksheet; 

 

 

 

 

 

 

 

 

 

 

x. develop an appreciation 

for sorting data; 

 

 

 

xi. become familiar with 

wrap text. 

 

Inserting new rows above any row 

 

 

Inserting a new worksheet 

1. Right-click any sheet tab at the lower left side of the 

screen to display the pop-up menu. 

2. Select Insert to display the Insert dialogue box. 

3. Select Worksheet then click the OK button. 

 

 

Sorting in alphabetical order 

Sorting is the arrangement of data in a specified sequence. 

When you edit your Excel data, you can arrange names 

alphabetically in ascending or descending order. 

 

Wrap text 

Wrap text is the process of formatting long text in a cell that 

overlaps the adjacent cell(s) so that it fits multiple lines in a cell. 

 

 

 

 

 

Inserting new rows 

above any row 

 

Inserting a new 

worksheet 

 

 

 

Editing cell data 

Sorting in 

alphabetically in 

ascending or 

descending order 

 

Applying wrap text to 

cell 
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WEEK 20 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION IV: USE 

OF APPLICATION 

SOFTWARE 

 

Formatting 

workbook 

 

Formatting 

worksheet cells as a 

table 

 

Linking documents 

 

 

 

 

 

 

 

 

Striping rows and 

Students will: 

i. develop an 

understanding of 

formatting a workbook; 

 

ii. become familiar with 

formatting worksheet 

cells as a table; 

 

 

 

 

 

iii. develop an awareness 

of linking documents; 

Formatting workbook 

1. Select the data to be formatted. 

2. Click on the appropriate button (B, I, U, Border, Fill 

Colour, Font Colour) on the Home tab in the Font 

group to apply the preferred formatting to the data. 

Formatting worksheet cells as a table 

1. Enter the headers in the range of cells on the 

worksheet and then select the range. 

2. On the Home tab, in the Styles group, click the 

Format as Table button. 

3. On the drop-down menu, click the preferred style to 

display the Format As Table dialogue box. 

Linking documents 

When you link data from one document (source document) to 

another (Dependent or Destination Document) and you edit 

the source document, the dependent or destination document 

automatically changes. 

Formatting workbook 

using B, I, U, Border, 

Fill Colour, Font 

Colour 

 

Formatting worksheet 

cells as a table 

 

 

 

 

 

 

 

Linking Excel 

document to a Word 

document 

Textbooks 

Electronic Document 

Preparation and 

Management, 

Caribbean Educational 

Publishers, 2021 

Pages: 142 – 45 

 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 102 – 12 

Oral questioning 

 

 

Practical 

Demonstration 

 

Practical Exercise 
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columns 

 

 

 

Delete cells, rows and 

columns 

 

 

 

 

 

 

 

Vertical and Oblique 

headings 

iv. become familiar with 

striping rows and 

columns; 

 

v. know how to delete 

cells, rows and 

columns; 

 

 

 

 

 

 

 

vi. appropriately create 

vertical and oblique 

headings. 

Striping rows and columns 

Striping is applying different shading to odd and even 

numbered rows and columns to make reading long rows 

easier. 

Deleting cells, rows or columns 

1. Select what you want to delete. 

2. Right-click and select Delete to display the Delete 

dialogue box. 

3. Click the radio button of what you want to delete and 

then click OK. 

Creating tabulation with vertical and oblique headings 

using Excel 

On the Home tab, in the Alignment group, click the 

Orientation button and select Vertical Text for vertical 

heading or Angle Counterclockwise for oblique heading. 

 

Orientation drop-down menu 

Creating a new 

workbook 

Striping rows and 

columns 

Stating the purpose of 

striping 

Deleting cells, rows 

and columns 

 

 

 

 

Creating tabulation 

with vertical and 

oblique headings 

using Excel 
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WEEK 21 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION IV: USE 

OF APPLICATION 

SOFTWARE 

 

 

Advanced Tabulation 

Formulae 

Mathematical 

operators and 

functions 

 

 

 

 

 

 

 

 

Some function 

formulae 

Students will: 

i. develop an 

understanding of the 

concept formulae; 

 

 

 

 

 

 

 

ii. become familiar with 

the mathematical 

operators and 

functions; 

Formulae 

A formula is a combination of signs (symbols), letters, and 

figures in the form of an equation that is used to calculate 

values. A formula is created by typing an equal sign, followed 

by the function name in uppercase, a left parenthesis, the 

arguments (operands or elements to be calculated expressed as 

a range or separated by commas or operators with no space), 

and a right parenthesis. 

 

Mathematical operators and functions 

Operators are symbols that link the operands of a formula to 

indicate the calculation to perform. The mathematical 

operators are: + (addition), - (subtraction or negation), * 

(multiplication), / (division), % (percent) and ^ 

(exponentiation). 

Describing formulae 

 

 

 

Identify the operator 

for writing formulae 

 

 

 

 

 

Writing formulae 

using mathematical 

operations and 

functions 

Textbooks 

Electronic Document 

Preparation and 

Management, 

Caribbean Educational 

Publishers, 2021 

Pages: 147 – 57 

 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 102 – 12 

Oral questioning 

 

 

Practical 

Demonstration 

 

Practical Exercise 
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AutoSum formula 

iii. develop an 

appreciation of the 

various function 

formulae; 

 

 

 

 

iv. become familiar with 

the built-in AutoSum 

formula. 

Some function formulae 

i. Mathematical and Trigonometric Function 

ii. Statistical Function 

iii. Logical 

iv. Date and Time 

v. Financial Function 

 

 

Using Microsoft Excel's built-in AutoSum formula 

1. Select the cell in which you want the result. 

2. Click AutoSum  on the Formulas tab, in the 

Function Library group or on the Home tab, in the 

Editing group to display the formula. 

3. Press the Enter key to enter the sum. 

Stating and using the 

various function 

formulae 

 

 

 

 

 

Using the built-in 

AutoSum formula 
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WEEK 22 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION IV: USE 

OF APPLICATION 

SOFTWARE 

 

Predefined function 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Drag and drop 

Students will: 

i. develop an 

understanding of how to 

use the insert function 

button to insert a 

predefined function 

formula; 

Using the insert function button to insert a predefined 

function formula 

 
 

 

 

 

 

 

 

Using the insert 

function button to 

insert a predefined 

function formula 

Textbooks 

Electronic Document 

Preparation and 

Management, 

Caribbean Educational 

Publishers, 2021 

Pages: 147 – 50 

 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 102 – 12 

Oral questioning 

 

 

Practical 

Demonstration 

 

Practical Exercise 
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Copy from cell to cell 

 

 

 

 

 

 

 

 

 

 

 

 

Copy from cell to 

range 

ii. know how to drag and 

drop cells; 

 

 

 

 

 

iii. develop an awareness 

to copy from cell to cell; 

 

 

 

 

 

 

 

 

 

 

iv. develop an awareness 

to copy from cell to cell; 

Drag and drop 

Select the cells (range) that you wish to move. Position the 

pointer on one of the corners. The pointer is attached to a 

cross with four arrows .) Drag the range to its new 

destination. 

 

Copying from cell to cell 

1. Select the cell with the formula/data to be copied. 

2. Copy the selection. 

3. Click on the new cell where you would like to copy 

the formula/data. Observe the shape of the cursor – a 

white cross. 

4. Paste the selected cell. 

5. Press the Escape key to remove the marquee. 

 

 

Copying from cell to range 

1. Select the range of cells with formula/data to be 

copied. 

2. Copy the selected range. 

3. Click on the new range where you would like to copy 

the formula/data. 

4. Paste the selected range. 

Dragging and 

dropping cells to a 

new destination 

 

 

 

 

Copying from cell to 

cell 

 

 

 

 

 

 

 

 

 

 

Copying from cell to 

range 
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Writing formula 

 

 

 

 

 

 

 

 

Formatting tables 

using %, $ and 

decimal 

 

 

v. become familiar with 

writing formulas using 

Sum, AVG, MIN and 

MAX; 

 

 

 

vi. develop the skills to 

format tables using %, $ 

and decimal. 

5.  Press the Escape key to remove the marquee. 

 

 

Writing formula 

i. Sum 

ii. Average 

iii. Min 

iv. Max 

 

 

Formatting tables using %, $ and decimal 

1. Select the range with the numbers. 

2. On the Home tab, in the Number group, click the $ 

button or the % button or the Increase Decimal or 

Decrease Decimal button  or click the Number 

dialogue box launcher. 

 

 

Writing formula 

 

 

 

 

 

 

 

 

Formatting tables 

using %, $, and 

decimal; invoices 

debit notes and credit 

notes 
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WEEK 23 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION IV: USE 

OF APPLICATION 

SOFTWARE 

 

Graphs and Charts 

Students will: 

i. develop an understanding 

of the creation and 

formatting of graphs and 

charts. 

Graphs and Charts 

A graph is a visual channel of communication using lines to 

show comparison. The horizontal (X) axis represents the 

variables or categories – data studies – and the vertical (Y) 

axis represents the frequency of the variables or values. 

A chart is a visual channel of communication on paper, slide, 

or screen using diagrams or illustrations to display information 

– data. 

 

Chart Types 

Defining the terms 

graphs and charts 

 

Explaining the chart 

types 

 

Creating charts and 

graphs 

 

Formatting charts and 

graphs 

Textbooks 

Electronic Document 

Preparation and 

Management, 

Caribbean Educational 

Publishers, 2021 

Pages: 150 – 7 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 204 – 8 

Oral questioning 

 

 

Practical 

Demonstration 

 

Practical Exercise 

SCHOOL-BASED 

ASSESSMENT: 

Students will: 

i. understand how to 

conduct research and 

ASSIGNMENT 2 

Assignment 2 involves an Electronic Research 

Candidates are expected to conduct research and present the 

Conducting research 

 

Obtaining required 

Textbooks 

Electronic Document 

Preparation and 

Practical Exercise 

 

Online Research 
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Assignment 2 present findings 

electronically. 

findings electronically using the skills developed. 

EXEMPLAR 

This is, for example, purposes only and must not be 

reproduced as part of the SBA to be submitted. 

As a travel agent, you wish to inform your clients which 

country in the Western Hemisphere had the lowest dengue 

fever infections in the last five years. 

 

Obtain and summarize the information, prepare it for 

dissemination via e-mail; and state all sources in an 

appropriate bibliography. 

OR 

The class has difficulty obtaining information for Specific 

Objectives 4 to 6 of the new Electronic Document Preparation 

and Management Syllabus. 

 

Obtain and summarise the required information from the 

internet and prepare it for dissemination to the class via e- 

mail, and state all sources in an appropriate bibliography. 

 

 

 

Prepare the presentation, including the following: 

information 

 

 

Summarizing the 

information (DO NOT 

PLAGIARISE) 

 

Compiling a 

bibliography of all 

sources used 

 

Presenting the findings 

 

Preparing the 

information for 

dissemination via e- 

mail 

 

Printing a copy of the 

email 

 

 

Saving the file to a 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 314 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 276 

 

 

 

Electronic Document 

Preparation and 

Management 

Syllabus 

Page: 28 – 29 
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  (a) difference between communication devices and 

communication media; 

(b) difference between operating software and application 

software; and, 

(c) the most common operating systems and the most 

common application software. 

storage medium   
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WEEK 24 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION IV: USE 

OF APPLICATION 

SOFTWARE 

 

Produce a 

professionally finished 

spreadsheet 

Students will: 

i. develop an appreciation 

of computation skills to 

produce a professionally 

finished spreadsheet. 

Further Practice ACTIVITY 
 

 
 

 

 
 

 

 

Creating a new 

worksheet 

 

 

Naming the workbook 

 

 

 

Naming of sheets 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Creating documents 

Textbook 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 102 – 12 

Practical Evaluation 
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by typing titles, labels 

and values 

Inserting cells 

Altering cell size 

Deleting cell contents 

Altering column width 

Altering row height 

Merging cells 

Inserting new columns 

to the left or right of 

any column 

 

Inserting new rows 

above any row 

 

Editing cell data 
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Continuation to ACTIVITY 12 

 

 

 

 

Apply font styles and 

sizes 

 

 

 

Aligning text and 

values in cells 

 

Applying borders 

 

 

Aligning table on the 

page 

 

Creating oblique and 

vertical headings 

 

Applying Wrap text 

Sorting data in a table 
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WEEK 25 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION IV: USE 

OF APPLICATION 

SOFTWARE 

 

 

 

What is a database? 

Database 

terminologies 

 

Data type 

 

 

 

Creation of a 

database 

Students will: 

i. become familiar with 

the concept of database 

and its purpose; 

 

ii. develop an awareness of 

database terminologies; 

 

 

iii. develop an 

understanding of the 

data type settings; 

 

 

iv. develop an 

understanding of 

creating a database file 

with a table and adding 

data. 

Database 

A database is an electronic filing system containing records or 

data related to a particular subject or purpose that can be 

retrieved for analysis and also be updated. 

Database terms: 

i. Tables 

ii. Records 

iii. Fields 

iv. Data type 

v. Reports 
 

 

Data type settings and the type of data that may be stored 

Defining the term 

database and 

explaining its purpose 

 

Explaining the terms 

table, records, fields 

and data type. 

 

Identifying the data 

type settings and the 

type of data that may 

be stored 

Creating a database 

file 

Creating a table 

 

Adding data to the 

table 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 131 – 37 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 147 – 49 

Oral questioning 

 

 

Practical 

Demonstration 

 

Practical Exercise 
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WEEK 26 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION IV: USE 

OF APPLICATION 

SOFTWARE 

Queries 

 

Types of queries 

Simple queries 

Sort queries 

Preparation of a 

report 

Students will: 

i. become familiar with the 

concept query; 

ii. develop an 

understanding of select 

queries and action 

queries; 

iii. demonstrate accuracy 

in performing simple 

queries; 

iv. develop an appreciation 

for sorting queries and 

preparing a report. 

Performing a simple query 

A query is access to information from a database table to look 

at data edit and analyze it and display specific information on 

a table. 

 

Queries that are used to retrieve data from a table or to make 

calculations are called select queries. Queries that add, change 

or delete data are called action queries. A select query is the 

most common type of query. It retrieves data from one or more 

tables and displays the results in a datasheet. 

Defining the term 

query 

 

Explaining the terms 

action query and 

select query 

 

Performing simple 

queries 

 

Sort queries 

Preparing report 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 135 

 

 

 

Electronic Document 

Preparation and 

Management, 

Caribbean Educational 

Publishers, 2021 

Pages: 158 – 65 

Oral Questioning 

 

 

Practical 

Demonstration 

 

Practical Exercise 

Play Typing Games using Mavis Beacon or Free typing games, typing lessons and typing tests. | FreeTypingGame.net 

https://www.freetypinggame.net/
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WEEK 27 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE 

EVALUATION 

STRATEGY 

SECTION IV: USE 

OF APPLICATION 

SOFTWARE 

 

Produce a 

professionally 

finished database 

Students will: 

i. develop an appreciation 

of computation skills to 

produce professionally 

finished queries and 

reports in a database. 

Further Practice ACTIVITY  

Creating database file 

 

 

Creating table 

 

 

Adding data to the 

table 

 

Performing queries 

Textbook 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 142 – 3 

 

Past CSEC papers 

Practical Evaluation 

Oral questioning 

End of TOPIC/ SUB- 

TOPIC test 
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Creating database file 

 

 

Creating table 

 

 

Adding data to the 

table 

 

Performing queries 

  

Play Typing Games using Mavis Beacon or Free typing games, typing lessons and typing tests. | FreeTypingGame.net 

https://www.freetypinggame.net/


GRADE 10 

Page 56 of 72 

 

 

 

WEEK 28 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE 

EVALUATION 

STRATEGY 

SECTION IV: USE 

OF APPLICATION 

SOFTWARE 

 

What is 

Presentation? 

 

Views on Microsoft 

PowerPoint 

Students will: 

i. develop an understanding 

of presentation and its 

purpose; 

 

 

 

ii. become familiar with the 

views in PPT; 

Presentation 

A presentation is an information about an idea or a proposal 

transmitted to an audience in the form of a slide show using 

presentation software. 

Views on Microsoft PowerPoint 

1. Normal, Full or Slide View (Tri-Pane View) 

i. Slides/Outline pane 

ii. Slide Area 

iii. Notes pane 

2. Outline View 

3. Slide Sorter View 

4. Notes Page View 

5. Slide Show View 

6. Master Views 

Views for presenting your slides 

1. Slide Show View 

2. Presenter View 

3. Reading View 

Defining the term 

presentation and 

explaining its purpose 

 

Stating the use of 

various Views on PPT 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 118 – 26 

Oral Questioning 

 

 

Practical 

Demonstration 

 

Practical Exercise 

 

 

 

 

 

 

Views for presenting 

your slides 

 

 

 

 

 

 

 

iii. become familiar with 

views for presenting 

slides; 

 

 

 

 

 

 

 

Identifying the 

different views for 

presenting 

Electronic Document 

Preparation and 

Management, 

Caribbean Educational 

Publishers, 2021 

Pages: 166 – 80 

 

Views for organizing 
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and printing your 

presentation 

 

 

Slide Master 

 

 

 

 

 

 

 

 

Slide layouts 

iv. become familiar with the 

views for organizing and 

printing presentations; 

 

 

v. develop an appreciation 

for the concept slide 

master; 

 

 

 

 

vi. appropriately use 

different slide layouts; 

Views for organizing and printing your presentation 

1. Slide Sorter View 

2. Print Preview 

 

 

 

Slide Master – This controls the formatting of the 

placeholders in the title and text placeholders and applies any 

change you make to all the slides in your presentation. 

i. Title master 

ii. Object Area 

iii. Templates 

Slide layouts 

1. Title slide 

2. Title and Content 

3. Section Header 

4. Two Content 

5. Comparison 

6. Title only 

7. Blank 

8. Content and Caption 

9. Picture and Caption 

Using views for 

organizing and 

printing your 

presentation 

 

Stating the use of slide 

master 

 

 

 

 

 

 

 

Identifying and using 

the different slide 

layouts 
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Creation of a simple 

presentation 

 

 

 

 

 

 

 

 

 

 

 

 

Save the slide as a 

picture 

 

 

 

 

vii. develop an 

understanding to 

properly create a 

presentation; 

 

 

 

 

 

 

viii. become familiar with 

saving a slide as a 

picture. 

 

 

Creating a presentation in a normal view 

1. Launch the Microsoft PowerPoint window with a 

Slide thumbnail at the left pane and a slide area at the 

right. 

2. Click on the Design tab to show template thumbnails 

of themes on the Ribbon. 

3. Point at each template thumbnails to display a larger 

image. 

 

Saving your slide as a picture 

1. Click on the slide you want to save as a picture. 

2. Display the Save As dialogue box. 

3. In the Save as type box, select an image format from 

the menu, e.g., GIP, JPEG, PNG, TIFF and click the 

Save button. 

 

Creating a 

presentation in a 

normal view 

Adding and editing 

text on the master 

slide 

Inserting a new slide 

Adding text to the new 

slide bulleted style 

 

Saving your slide as a 

picture 

  

Play Typing Games using Mavis Beacon or Free typing games, typing lessons and typing tests. | FreeTypingGame.net 

https://www.freetypinggame.net/
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WEEK 29 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION IV: USE 

OF APPLICATION 

SOFTWARE 

PPT Insert Tab 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PPT Design Tab 

Students will: 

i. develop an understanding 

of the use of various 

features of the Insert tab 

ribbon; 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ii. become familiar with 

the features on the design 

Insert tab 

i. New slide 

ii. Table 

iii. Pictures 

iv. Shapes 

v. SmartArt 

vi. Chart 

vii. Textbox 

viii. WordArt 

ix. Date and Time 

x. Slide Number 

xi. Object 

xii. Video 

xiii. Audio 

 

 

Design Tab 

i. Slide size 

Inserting the various 

features from the 

Insert tab, e.g., new 

slide, pictures, date 

and time, slide number 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Adjusting the slide 

size and formatting the 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 118 – 26 

 

 

 

Electronic Document 

Preparation and 

Management, 

Caribbean Educational 

Publishers, 2021 

Pages: 166 – 80 

Oral Questioning 

 

 

Practical 

Demonstration 

 

Practical Exercise 
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 tab; 

iii. develop an 

understanding to use the 

transition tab; 

 

 

 

 

 

iv. appropriately use the 

animation tab; 

ii. Background format 

Transition tab 

This is the visual and sound effects applied to movements on 

the screen to launch a new slide. Transition settings determine 

how a new slide enters the screen and the previous one exits 

on its own. You can control the speed and sound effects. 

 

Animation tab 

This is how each component of a slide, e.g. text or an object 

moves onto a slide and how long it remains during a slide 

show presentation. You can set text to appear by letter, work, 

or paragraph. Visual effects can be applied. 

background 

Applying transition(s) 

to slides 

 

 

 

 

 

 

 

 

 

Applying animation to 

text and objects on 

slides 

 

Setting the timing 

 

 

Printing a presentation 

  

Play Typing Games using Mavis Beacon or Free typing games, typing lessons and typing tests. | FreeTypingGame.net 

https://www.freetypinggame.net/
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 WEEK 30 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION IV: USE 

OF APPLICATION 

SOFTWARE 

 

Export presentation 

to a Word document 

 

Import an Excel 

worksheet or a Word 

document into a 

presentation 

 

Effective 

communication 

Students will: 

i. become familiar with 

exporting a presentation 

to a Word document; 

 

ii. develop an awareness to 

import Excel worksheets 

or a Word document into 

a presentation; 

 

iii. develop an appreciation 

of effective 

communication using 

PPT. 

Export presentation to a Word document 

 

 

Import an Excel worksheet or a Word document into 

your presentation 

 

Effective communication improves relations with the 

audience. Test sound system and equipment. Your slides and 

notes must contain graphics for an audience who absorb 

content visually and sound effects for those who absorb by 

hearing. Bullet your points and bold your text to make them 

more visible. Content must be accurate, clear, and complete 

to produce the desired effect. Know your audience and 

maintain a good posture. Use simple language and control 

question and answer with eye contact. Repeat questions 

when necessary. Obtain feedback and recap at the end. 

Exporting presentation 

to a Word document 

 

Importing an Excel 

worksheet or a Word 

document into your 

presentation 

 

Discussing effective 

communication 

 

Adding sound effects 

to a slide and the 

presentation 

 

Hide the sound icon 

Textbook 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 118 – 126 

 

Electronic Document 

Preparation and 

Management, 

Caribbean Educational 

Publishers, 2021 

Pages: 166 – 180 

Oral Questioning 

Practical Exercise 
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Further practice ACTIVITY  

 

 

 

Creating a 

presentation file 

 

Using and adding 

different slide layouts 

 

Using a template 

 

Adding an image to a 

slide 

 

Applying transition(s) 

and animations to 

slides 

 

Adding sound effects 

to a slide 

 

Producing 

presentations that are 

effective for 

communication. 

Past CSEC papers 

2018 and 2023 
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GRADE 10 

Page 64 of 72 

 

 

 

WEEK 31 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SCHOOL-BASED 

ASSESSMENT: 

 

Assignment 3 

Students will: 

i. display a professionally 

finished presentation. 

Assignment 3 

Teachers can use scenarios (real or imagined) that will allow 

the students to use various applications to design documents, 

such as flyers, menus, invitations and newsletters which will 

enable them to engage their creative abilities. 

EXEMPLAR 

This is, for example, purposes only and must not be 

reproduced as part of the SBA to be submitted. 

You are a teacher of the new and exciting CXC subject, 

Electronic Document Preparation and Management. In your 

school, there are large overhead monitors for classroom 

presentations. You want to present the content of Section I, 

Objectives 1 to 3, to the class clearly and interestingly using a 

PowerPoint or Lotus presentation. 

Prepare the presentation, including the following: 

(a) definition of the term ‘computer’; 

(b) components of the computer system; and, 

(c) functions of various hardware devices. 

 

Creating PowerPoint 

Presentations 

 

Presenting to the 

subject teacher 

 

Making necessary 

corrections 

Textbook 

 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 315 

 

 

 

Syllabus 

Page: 29 

Practical Exercise 

Presentation 
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 WEEK 32 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION IV: USE 

OF APPLICATION 

SOFTWARE 

 

SUB-TOPIC/ SUB- 

TOPICS 

Working with Access 

data in Excel 

 

 

 

What is mail merge? 

 

 

 

 

 

Components of mail 

merge 

Students will: 

i. become familiar with the 

ways to take data into 

Excel from Access; 

 

 

 

 

 

ii. develop an 

understanding of the 

concept of mail merge; 

 

iii. become aware of the 

components of mail 

merge; 

Working with Access data in Excel 

There are several ways to bring data into Excel from Access. 

You may: 

i. copy data from an Access database and paste it into 

an Excel worksheet; 

ii. connect to an Access database from an Excel 

worksheet; 

iii. export Access data into an Excel worksheet. 

 

 

Mail merge is a software function that guides you through a 

process to produce several documents – letters, e-mail 

messages, envelopes and mailing labels – from a template. 

 

To create a mail merge, you need the following components: 

i. Main document 

ii. Data source 

iii. Merge document 

Stating the ways to 

take data into Excel 

from Access 

 

Copying Access data 

to Excel 

 

 

 

 

Explaining the concept 

of mail merge and 

associated 

terminologies 

 

Stating the 

components of a mail 

merge 

 

Setting up the main 

Textbooks 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 144 – 49 

 

 

 

Electronic Document 

Preparation and 

Management, 

Caribbean Educational 

Publishers, 2021 

Pages: 181 – 86 

Oral questioning 

Practical Exercise 

Take home 

assignment 
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Steps in a Mail Merge 

Process 

iv. develop the mastery to 

accurately perform a mail 

merge using an external 

data source. 

Steps in a Mail Merge Process 

i. Create the Main Document with the identical 

information for the merge document and save it. 

ii. Create the Data Source with the different 

information (merge fields) to be merged into the main 

document and save it. 

iii. Open the main document. 

iv. Edit your data file. 

v. Insert placeholders, and call merge fields, at the 

correct destinations. The merge fields are placed 

within chevrons << >>. 

vi. Preview the first new document, if necessary. 

vii. Complete the merge to show the new document(s). 

viii. Print the new documents (s). 

document 

 

 

Creating a data source 

table 

 

Choosing a Microsoft 

Access database data 

file 

 

Adding mail merge 

fields to the document 

 

Previewing the mail 

merge 

 

Printing the merged 

documents 

  

Play Typing Games using Mavis Beacon or Free typing games, typing lessons and typing tests. | FreeTypingGame.net 

https://www.freetypinggame.net/
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WEEK 33 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SECTION IV: USE 

OF APPLICATION 

SOFTWARE 

 

Information 

Integration 

Students will: 

i. become familiar with the 

integration of 

information to produce 

professionally finished 

documents for 

dissemination. 

Further Practice ACTIVITY Setting up the main 

documents 

 

Using steps to 

complete mail merge 

wizard 

 

Creating data source 

tables 

 

Adding mail merge 

fields to the document 

 

Previewing the mail 

merges 

Textbook 

 

Electronic Document 

Preparation and 

Management for 

CSEC, 2nd Edition, 

Oxford University 

Press, 2014 

Pages: 150 

 

 

 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 152 

Oral Discussion 

Practical Exercise 

End of TOPIC/ SUB- 

TOPIC test 
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 WEEK 34 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

SCHOOL-BASED 

ASSESSMENT: 

 

Assignment 3 

Students will: 

i. display a professionally 

finished presentation. 

CONTINUATION OF SBA 

EXEMPLAR 

This is, for example, purposes only and must not be 

reproduced as part of the SBA to be submitted. 

 

You are a teacher of the new and exciting CXC subject, 

Electronic Document Preparation and Management. In your 

school, there are large overhead monitors for classroom 

presentations. You want to present the content of Section I, 

Objectives 1 to 3, to the class clearly and interestingly using a 

PowerPoint or Lotus presentation. 

 

Prepare the presentation, including the following: 

(a) definition of the term ‘computer’; 

(b) components of the computer system; and, 

(c) functions of various hardware devices. 

 

 

Creating PowerPoint 

Presentations 

 

Presenting to the 

subject teacher 

 

Making necessary 

corrections 

 

Submitting 

PowerPoint 

Presentation to the 

subject teacher 

Mark Scheme 

 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 315 

 

 

 

Syllabus 

 

Page: 29 

Oral Discussion 

Practical Exercise 

Play Typing Games using Mavis Beacon or Free typing games, typing lessons and typing tests. | FreeTypingGame.net 

https://www.freetypinggame.net/
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 WEEK 35 

TOPIC/ SUB-TOPIC GENERAL OBJECTIVE CONTENT ACTIVITY RESOURCE EVALUATION 

STRATEGY 

Week 34 cont.d 

 

SCHOOL-BASED 

ASSESSMENT: 

 

Assignment 3 

Students will: 

i. display a professionally 

finished presentation. 

Prepare the presentation, including the following: 

(a) definition of the term ‘computer’; 

(b) components of the computer system; and, 

(c) functions of various hardware devices. 

 

Submitting 

PowerPoint 

Presentation to the 

subject teacher 

Mark Scheme 

 

Electronic Document 

Preparation and 

Management for 

CSEC, Macmillan 

Education, 2012. 

Pages: 315 

 

 

 

Syllabus 

 

Page: 29 

Oral Discussion 

Practical Exercise 

 

 

Additional Resources 

Website 
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(7) What is word processing? - YouTube 

(7) 1.2 What is a Spreadsheet - YouTube 

(7) What Is a Database Management System? | What Is DBMS? - YouTube 

(7) Presentation software and characteristics - YouTube 

(159) CSEC IT: Microsoft Word | Formatting Features Part 1 - YouTube 

(159) CSEC IT: Editing Features in Microsoft Word Using Columns - YouTube 

(159) Tabulation/Tabular Work (Part 1)| CSEC EDPM - YouTube 

(159) Tabulation in MS Excel (Part 2)| Spreadsheet| CSEC EDPM - YouTube 

(159) CSEC EDPM| Database| Complete Overview - YouTube 

(159) CSEC EDPM| Database Practice Question - YouTube 

(159) The Beginner's Guide to Microsoft PowerPoint - YouTube 

(159) Mail Merge| MS Word| CSEC EDPM - YouTube 

 

Other suggested Teaching and Learning ACTIVITY facilitate students’ attainment of the objectives of this Section. 

To facilitate students’ attainment of the objectives of this syllabus, teachers are advised to engage students in the teaching and learning activities listed below. 

1. Arrange students into small groups and assign them different application software to be researched. Their findings should be used to facilitate class discussions. 

2. After the teacher demonstrates the application of different software, students should be engaged in activities which allow them to select and apply them to different cases. Teachers should 

ensure that aspects of the SBA are covered in the exercises completed by the students. 

Engage students in the ACTIVITY relevant to the completion of Assignments 2 and 3 of the SBA. During these activities, they should use the feedback given during the practice exercises done 

in Section II as their guide. 

The teacher should ensure that there is at least one activity related to techniques or skills to be mastered, as well as each software to be applied. 

https://www.youtube.com/watch?v=ZkNMEURVUzY
https://www.youtube.com/watch?v=XYGubkLrRtA
https://www.youtube.com/watch?v=lDpB9zF8LBw
https://www.youtube.com/watch?v=Eo58skZO7Hs
https://www.youtube.com/watch?v=VmsC_eyK0S0
https://www.youtube.com/watch?v=L37HPtCxAFE
https://www.youtube.com/watch?v=Q75SO_3YfAQ
https://www.youtube.com/watch?v=jPYuJwci-v4
https://www.youtube.com/watch?v=jqjrLoM91mA
https://www.youtube.com/watch?v=GZjhEFnlS1Y
https://www.youtube.com/watch?v=XF34-Wu6qWU
https://www.youtube.com/watch?v=yOOMI-qRiB4

